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EE816 Design and Characterization of Microwave Systems 
 
I. Course Structure - 4 credits   
II. Pre-requisites – Microwave Circuits (EE717) and Antenna Theory (EE729) 
III. Course level – Graduate 
 
IV. Course Objectives  
 
Electromagnetics education has been rejuvenated by three emerging technologies, namely mixed 
signal circuits, wireless communication and bio-electromagnetics. As hardware and software 
tools continue to get more sophisticated, there is a need to be able to perform specific tasks for 
characterization and validation of design, working within the capabilities of test equipment, and 
the ability to develop corresponding analytical formulations  
 
There are two primary course objectives. 
 
(i) Design of experiments to characterize or measure specific quantities, working with the 

constraints of measurable quantities using the vector network analyzer, and in conjunction 
with the development of closed form analytical expressions.  

(ii) Design, construction and characterization of microstrip circuitry and antennas for a specified 
set of criteria using analytical models, and software tools and measurement techniques.   

 
Microwave measurement will involve the use of network analyzers, and spectrum analyzers in 
conjunction with the probe station. Simulated results will be obtained using some popular 
commercial EM software for the design of microwave circuits and antennas. 
  
V. Textbook and References 
 
1. Microwave Engineering by D.M. Pozar (3rd Ed) 
2. Antenna Theory by C. A. Balanis 
3. IEEE Journal Papers  
 
VI. Course Content 
 
(i) Design of experiments  

Characterizing phase shift, modeling discontinuities, measuring dielectric constant, cavity 
resonances, dispersive waveguides, impedance matching. 

(ii) Microwave circuit design projects 
Microstrip power dividers, corporate feed system, matching circuits, coupled line couplers, 
branchline couplers, hybrid ring couplers, and resonators Low pass and band pass filters 

(iii) Microwave measurement techniques 
 Scattering matrix, reflection and input characteristics, transmission characteristics 
  
Course Requirements: 
Tests / quizzes: 30% 
Lab: 30% 
Projects:40% 
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Experiment 1 

Dispersion Characteristics of Rectangular Waveguides 
 

 
Objective 
 

This experiment provides an introduction to the dispersive characteristics of waveguides 
and the techniques for waveguide measurements.  It is up to you to explore the problem to the 
extent necessary, to learn how precision measurements can be made. 
 

Frequency 
Sweep  
Oscillator

Attenuator Frequency 
Meter

Slotted x-band 
Waveguide

SWR 
meter

Coax to 
Waveguide 
Adapter

zl

 
 

Fig. 1  Circuit Configuration 
 
Procedure 
 

Measurements are conducted in the X- band using the WR-90 waveguide (dimensions 
0.4" x 0.9").  The recommended operating range for the TE10 mode is 8.2 to 12.4 GHz.  The 
oscillator range is 8 to 12 GHz. 
 
 
Part 1 - Dispersive Characteristic of Waveguides 
 
(i) With a short circuit as the waveguide termination, measure the guide wavelength of the TE10 

mode, λ10 , at discrete frequencies, in the range 8-12 GHz. Measure also, the frequency using 
the frequency meter.  

 
(ii) While doing this, measure Standing Wave (SW) pattern at 10 GHz. (It is not required to 

measure the SW pattern at the other frequencies). Take measurements for a distance of one 
and a half wavelengths of the slot.  



 5

(iii) From your results: 
 

• Plot standing wave pattern at 10 GHz. The meter reading is 
)z(V

Vmax . Plot the reciprocal of 

the meter reading vs.distance, z,  to generate the SW pattern   
• In the frequency range 8 GHz to 12 GHz, tabulate the measured guide wavelength, λ10  
• Corresponding to the frequency range for the measurements, calculate the theoretical λ10 

using the formula 

  2
10,c

2
0

2
10

111
λ

−
λ

=
λ

                                                              

 
where the cutoff wavelength of the TE10 mode is: 

λ c10 =
c

f c10    
            and the cutoff frequency of the TE10 mode is : 

                                   
f

c
ac10 2

=
        

• Plot and compare theoretical and measured λ10 
• Plot the dispersion characteristic of the waveguide, that is, β10 as a function of ω 

 
Part 2 -  Comparison of slotted line and automated measurements 
 
Using the microstrip antenna as the load terminating the slotted line, measure VSWR for the 
frequency range 8-12 GHz.  The same result using the Network Analyzer has been provided to 
you.  Choose the frequencies for measurement, necessary to duplicate this graph.   
 
From your results: 

• Plot VSWR vs. frequency, ƒ 
• Plot  |Γ|  vs.  ƒ 
• Determine the bandwidth for VSWR  ≤  2.0 

 
Report 
The report should contain the following. 

(i) A title, an objective and a block diagram 
(ii) Relevant theory and the derivation of the dispersion equation. 
(iii)For each part 

 an experimental procedure 
  measured data presented comprehensively 
  relevant calculations 

(iv) Conclusion and discussion 
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Experiment II 
Introduction to the Network Analyzer 

  
 I. Waveguide Calibration Procedure for PNA8363B   
Make sure the System characteristic impedance (Z0) is set to 1Ω  
System → Configure  →  System Z0 (set it to 1Ω) 
Select Start (8GHz) and Stop (12GHz) frequencies 
Cal 
 F1 (Cal Wizard) 
  Unguided Calibration: Use Mechanical Standards. (Create new Cal Set) 
  Click Next. 
 Full SOLT 2-Port (View or Select Cal Kit, Omit Isolation, 1 Set of Stds.). 
  Click Next. 
 ID #25 X11644A X-Band Waveguide SOLT/TRL Cal. 
  Click Next. 
 Port1: Attach λ/8 short, click short, click OK. 
 Port1: Attach 3λ/8 short, click offset short, click OK. 
 Port1: Attach matched load, click load, click X-Band fixed load, click OK. 
   

Attach the ports together, click thru, click X-band thru, click OK. 
   

Port2: Attach λ/8 short, click short, click OK. 
 Port2: Attach 3λ/8 short, click offset short, click OK. 
 Port2: Attach matched load, click load, click X-Band fixed load, click OK. 
  Click Next. 
 No. Finish now. 
  Click Finish. 
II. Transmission Line Calibration Procedure for PNA8363B 
Perform the calibration for a full two port for the X-band (8GHz to 12 GHz) 
 
Make sure the System characteristic impedance (Z0) is set to 50 Ohms 
Select Start and Stop frequencies  
Calibration  Calibration Wizard 
Select unguided calibration  
Click NEXT 
Choose 2 port SOLT  Click view select cal kit  Choose 85052D 3.5mm  
Click OK and NEXT 
Follow the procedure for each load 
 
III. Microstrip Antenna 
For the microstrip antenna provided to you, measure and plot the following 
• Plot VSWR vs. frequency, ƒ (8GHz – 10 GHz) 
• Plot  Return Loss  vs.  ƒ (8GHz – 10 GHz) 
• Determine the bandwidth for VSWR  ≤  2.0 
Compare the above with measurements made for the same antenna using the WG slotted line 
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Experiment III 
Characterizing and Calibrating Probe Susceptance  

 
Objective 
 
The objective is to measure and calibrate the susceptance of a tuning post vs. depth of 
penetration in an X-band waveguide. The graph that is generated will be used for impedance 
matching by a single stub tuner.  
 
  

d
b

a

0.5
1.0

beq

d/b

 
  

Figure 1 Probe Susceptance 
 
The equivalent circuit of the post, inserted in a waveguide as shown in figure 1, is a symmetric T 
where both the series reactance and the shunt suseptance vary with insertion depth (The series 
reactance is relatively small and can be neglected here).  At small insertion depths the 
susceptance is capacitive and it increases with the depth, d.  This increase can be attributed to the 
increase of the capacitance between the tip of the post and the bottom surface of the waveguide.  
In series with this capacitance is the inductance of the exposed post and this inductance also 
increases with 'd'.  At some depth, the post becomes a series resonant circuit (i.e. beq = ∞).  and 
is inductive for greater depths up to and including maximum insertion, when d = b, the smaller 
WG dimension.   
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Method I- With Network Analyzer and a matched load termination 
 
The experimental setup is shown below in figure 2. 
 
 

Network 
Analyzer 
8720B

WG-Coax 
adapter

Slide 
Screw Tuner

Matched 
Load

 
 
 

bSWR
d

Matched
Load

Tuning Probe

SST

yojβeqSWR

 
  

Figure 2 Experimental setup with a matched load termination 
 
(i) Calibration the network analyzer for S11 measurements in the X-band waveguide for a 
frequency range 8-12 GHz 
 
(ii)  With the circuit as shown, measure the SWR at 10 GHz for insertion depth, d, ranging from 

0 to b. 
 
(iii)  From the equivalent circuit shown above, obtain the following expression for beq. 
 

      
beq = ±

SWR − 1
SWR

⎡ 
⎣ ⎢ 

⎤ 
⎦ ⎥ 

 
 
(iv)  Generate a calibration design graph (figure 3) by calculating and plotting beq vs. d/b shown 
in figure 1. 
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Method II - With the Waveguide Slotted Line and a short as termination 
 
  
In this method, the probe susceptance is measured using a shorting plate as a termination. The 
experimental setup is shown in Figure 4.   
 

Frequency 
Sweep  
Oscillator

AttenuatorCoax to 
Waveguide 
Adapter

SST

Matched 
Load

or

shorting 
plate

Tuning 
Post

Frequency 
Meter

Slotted x-band 
Waveguide

SWR 
meter

 
 

Figure 2 Waveguide slotted line with a short as termination 
 
 
(i) Retract the probe of the SST fully (> 0.4" on micrometer screw) 
 
(ii) Set the frequency to 10 GHz. 
 
(iii) Terminate the end of the SST with a shorting plate and fix the position of the post a distance 
which is an odd multiple of λg / 4 . This ensures that the shorting plate presents an open circuit at 
the plane of the tuning post of the SST.  When the tuning post is inserted into the guide, the 
effective load will be the suseptance presented by the post. 

 
(iv) For insertion depths starting from 0.4" on the micrometer screw, obtain the position of the 
first accessible voltage minimum in the slotted line.  Take readings for every 0.05" insertion 
depth.  Tabulate your readings as shown in Table 1. 
 

   d’ 
Micrometer 

Reading 

 
Depth, d= (b-d’) 

 
d/b 

 
Position of
1st Vmin 

 
 (l − lo )

 
]/)(2tan[b 10oeq λ−π−= ll

 
0.4" 0.0" 0.0  lo    
0.35" 0.05" 0.125  l    

: : : :   
0.0" : : :   

 
Table 1  

 
(v) Calculate beq for each insertion depth and plot beq vs. d/b.. 
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Experiment - IV 
Impedance Matching - The Slide-Screw Tuner (SST) 

 
 
Objective: 
 The waveguide equivalent of a single stub co-axial tuner is the slide-screw tuner which  
consists of a post that is inserted into the waveguide, through a slot, which is cut along the top 
surface.  In the design of the single stub tuner, a susceptance is introduced in parallel at a 
location where the real part of the input admittance equals the characteristic admittance. The 
axial location, l, of the post is adjustable. The depth of insertion, d, yields the desired 
susceptance so that the design can be implemented.   
 
 
 
 
 
 

d
b

a

0.5
1.0

beq

d/b

 
  
                                                                Figure 1 Single stub tuner 
 
The calibration of the probe susceptance vs insertion depth shown in figure 1, has been obtained 
in experiment II   At small insertion depths the susceptance is capacitive and it increases with the 
depth, d.   At some depth, the post becomes a series resonant circuit (i.e. beq = ∞).  and is 
inductive for greater depths up to and including maximum insertion, when d = b, the smaller WG 
dimension.   
 
The objectives of the experiment are as follows: 
(i) Calibrate the suseptance of the tuning post as a function of insertion depth, d. (This has been 

completed in Experiment #2) 
(ii) Measure the unknown impedance of the open ended WR-90 waveguide 
(iii)Using the slide screw tuner, design a single stub tuner to match the open-ended guide 

impedance, to obtain  SWR = 1. That is,  
• Find the distance of the tuning post from the open end  
• Use the probe susceptance calibration graph to determine the depth of insertion of 

tuning post.  
(iv) Implement the design and measure SWR. Report SWR before and after matching. 

A

ZL  Z0 (=ηTE10) Z0 YS = ±jBS 

lA
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Procedure 
 
Part 1: Calibration Graph for Suseptance vs. Probe Depth  
 
Completed in Experiment #2 
 
 
Part II: Measurement  of unknown impedance of Open-ended Waveguide 
 
(i) Slotted Line Measurement for Unknown Impedance 
 
Any load impedance entered on the SC is completely defined by the SWR and the distance to the 
first voltage minimum or maximum.. However, the plane of the load is not always accessible as 
in the case of a slotted line. If the distance to the first maximum dmax (or to dmin ) can be 
measured the unknown load impedance LẐ  can be obtained. Since this s not possible, the 
following method is used. The two possible kinds of load impedances (capacitive or inductive) 
are considered, in the first case where voltage minimum occurs and in the other a voltage 
maximum occurs first from the load. The measurement methodology is outlined below. 
  
(a) With an unknown load LẐ attached to the end of the slotted line 

• Measure the SWR 
• Locate the first accessible minimum at dmin,1 

 
(b) Replace the load with a short 

• Locate the first accessible minimum at dmin,2 
• Note the direction of the shift, whether towards the generator or load. 

 
(c) Perform calculations on the Smith Chart 

• Draw the SWR circle corresponding to the unknown impedance 
• Calculate Δd = dmin,1 - dmin,2 
• From the point of voltage minimum, rotate a distance λ

Δd  in the direction of the shift. 

• Draw a line to intersect the SWR circle. 
• Read zL and de-normalize to obtain ZL. 

zl

Vmin Vmax

SWR=Γ

²d / λg 
(toward gen)

 
 

Figure 2  Smith Chart Calculations 
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Capacitive Load  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Inductive Load 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3 Measurement of Unknown Impedance 
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LẐ    
+ 

gẐ  
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(ii) Network Analyzer Method for Unknown Impedance 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4 Impedance Measurement 
 
Direct measurement of impedance can be made using the network analyzer. The experimental 
setup is shown in figure 4.  

• At 10 GHz, calibrate the network analyzer for reflection at plane AA..  
• Verify the calibration with a short at AA.(Use Electrical Delay if necessary) 
• Attach the slide screw tuner and take the probe completely out of the WG . 
• Place a short at the open end. Use electrical delay to move the reference plane to BB. 
• Remove the shorting plate and measure impedance (displayed on the Smith Chart) of the 

open ended waveguide  
• Compare this result with that obtained from slotted line measurements. 

 
 
 
Part III Design of Single Stub Tuner. 

 

 

 

 

 

Figure 6 Single Stub Tuner 

  
The single stub tuner uses shunt susceptance (±jBS) connected in parallel at distance, l, from a 
load impedance, LẐ .The design is to obtain distance, l, and ±jBS (and hence the required probe 
depth, d) such that at the plane, AA, of the stub the total impedance, ZT,AA = Z0. The arrangement 
is shown in figure 6.  Design the single stub tuner. Set the probe of the SST to the design values. 
Measure SWR.(should be < 1.03). 

 
 

ZL (Open ended WG) Z0 (=ηTE10) Z0 YS = ±jBS 

l 

A

 

Network  
Analyzer 

Co-ax to  
WG adapter 

Open ended WG 

Calibration 
plane 

Slide Screw Tuner 

Tuning Stub  
(all the way out) 

A 

A 

B 

B 
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Experiment - V 

Measurement of Dielectric Constant 
 
 
Objective:  To determine the dielectric constant of a given material by placing a sample in a 
rectangular waveguide and solving by using a transmission-reflection concept.  
 
 
 
   
 
 
 
 
 

 
 

(a) 
 

 
 
   
 
 
 
 
 

 
  
 

 
You are provided with four dielectric samples, two of which have the same dielectric constant 
but are of different thicknesses.  
 
(i) Calibrate the Network Analyzer at plane AA 
(ii) Using a movable short, create the conductor-backed dielectric configuration shown fig (a). 
(iii)Measure zAA  Obtain )(

10

FS
TEAAAA zZ η=  

(iv) Measure AAz′  in the configuration shown in (b). Obtain )(
10

FS
TEAAAA zZ η′=′  

(v) Calculate the dielectric constant using the following formula 

 ( ) 2
)1(

10
2

)(
)()(

120
f

f
AAZAAZ

c
r +

′
=

πε  

 
 

 

Port 1 
of  
Network  
Analyzer 

Coax 
to 
WG 

Dielectric Holder 

εo εr 

Metal Plate 
A

A

λ/4 d 

Coax 
to 
WG 

Port 1 
of  
Network  
Analyzer 

Dielectric Holder 

εo εr 

Metal Plate A 

A 

d 
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Experiment VI 
Design of a Waveguide Phase Shifter 

 
Objective 
 To design a phase shifter using the Magic Hybrid Tee. 
 Tomeasure the scattering matrix of the Magic Hybrid Tee. 
 
Procedure 
I. Phase Shifter 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

(i) Calibrate NA for a full 2-port in the X-band. 
(ii) Connect the Magic Tee to the network analyzer as shown in fig. 1. 
(iii)For four different frequencies (8.5, 9.0, 9.5 and 10.0 GHz) vary the length of the movable 

short. For each turn, measure the phase angle of S21 as follows. 
 MEASURE  

Trans: FWD S21 
 FORMAT  

POLAR 
 Use the MARKER menu to position markers at each of the desired frequencies. 

 
(iv)Plot a graph of 'φ21 vs. l  / λg' for each frequency. 
(iv) For each graph superimpose theoretical graphs using the equation derived in Quiz #3.    

  
II.Hybrid Tee Scattering Matrix 
 
Determine the scattering matrix values at four frequencies (8.5, 9.0, 9.5 and 10 GHz).  
(Note: Six different configurations as two port measurements will be necessary.   

FORMAT  
POLAR 

MARKER menu to position markers at each of the desired frequencies. 
MEASURE   
S11, S21, S12 and S22  

1 2 

3 

4 

Movable 
short

NA port #1 NA port #2 
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Experiment VII 
Waveguide Irises 

 
Objective 

To measure the susceptance, beq, of capacitive and inductive irises. 
 

Procedure 
 
Part 1 Using the Network Analyzer and a Matched Load 
 
1. Calibrate the Network Analyzer for a Full two port  
2. Five different type of irises, shown  below, are available in the lab, each type as a pair and 

each set with five different dimensions for δ. 
 

 
 

Waveguide Irises and Equivalent Circuits 
 

3. Connect each iris and matched load to the adapter at port #1 of the NA. 
 
 
 
 
 
 
 
 
 
4. Do the following. 

MEASURE  
Refl: FWD S11 

MARKER (position markers at 8, 10 and 12 GHz) 
FORMAT 

SWR (record or plot the SWR) 
5. Calculate susceptance for each iris and average for each pair.  
 

  b
SWR

SWReq = ±
−( )1

 

 
6.  Compare measured susceptance with graph provided 

 
Network 
Analyzer 

Co-ax to 
WG Adapter 

 Port #1 Port #2 

Iris Matched Load 
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Part II. Using the Slotted Line and an Adjustable Short 
 

1)  Select one iris from each of the five iris pairs; hence, a total of five irises will be used.  
For each of the five irises, the susceptance at three different frequencies (8.0, 10.0, and 
12 GHz) will be determined. 

 
2)  For each frequency, the adjustable short must be positioned at an odd multiple of λg / 

4.  Use the Network Analyzer to obtain the proper position. 
 
 Connect the adjustable short to port 1. 
  
 Under the MEASURE menu select: Refl: FWD S11 

    Under the FORMAT menu select:  SMITH CHART 
 Use the MARKER menu to position a marker at a particular frequency. 
 To ensure fast tracking select AVERAGING OFF under the AVERAGE menu. 
 
 Adjust the short to obtain an open circuit at port 1. 
 
3)  Connect only the adjustable short to the slotted line. 
4)  Record the position of the reference voltage minimum, lo, for the particular frequency. 
5)  Connect an iris and the adjustable short to the slotted line.  Record the new position of 

the voltage minimum, l. 
 
 NOTE:  The absolute difference between the voltage minimum points, (l- l0) should 

not be greater than λg / 4.   
 
6)  Repeat step 5 for the remaining irises at the particular frequency. 
 
7)  Repeat steps 2 - 6 for each frequency. 
 
8)  Susceptance values may be calculated using the following equation: 
 

  b l leq
g

= − −
⎛

⎝
⎜

⎞

⎠
⎟tan ( )

2
0

π
λ
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Experiment VIII  
Design and Analysis of a  

Waveguide Filter and Frequency Meter 
 

Objective:  To measure the resonant frequencies of waveguide filters and frequency meters. 
             and to compare with predicted results. 

 
 
Part A: Waveguide filters 
 
I. Predicted Results 
 
(i)Record the average susceptance value, at 10 GHz, for each iris pair from the data obtained 

inExperiment 6 on Waveguide Irises.) 
(ii) Measure the length ‘l’ of the waveguide that you will be using to construct the filter (fig 1). 
(iii)Using the average susceptance values for an iris pair, calculate the resonant frequencies of 

each filter.   
 
 
 

 
 
 

 

Fig.1  Block Diagram of Waveguide Filter 

II. Measurements  
(i) Using an identical pair of irises, construct each filter and use the Network Analyzer to plot 

the forward reflection, S11 and the forward transmission, S21, over the frequency range of 8-
12 GHz. Using the following steps. 

• Calibrate the network analyzer for full 2- port measurements. 
• Verify the Calibration  
• For each filter, plot S11 and S21 on the same graph. 
   DISPLAY   
:  DUAL CHANNEL ON  

MORE 
   SPLIT DISPLAY OFF  

 Select CHANNEL 1 
 FORMAT  

LINEAR MAGNITUDE 
  MEAS 

REFL: FWD S11 
 Select CHANNEL 2 
  FORMAT 

Port 1 
of  

N. A. 

Port 2 
of  

N. A. 

Coax - 
Waveguide 

Adapter 

Coax - 
Waveguide 

Adapter 
Waveguide 

Iris Pair

l
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LIN MAG 
MEASURE 

TRANS: FWD S21 
 

(Note: Channel 1 and channel 2 have independent vertical axes. To bring both channels into full  
            view, the scaling of the vertical axis may be required.) 

Select CHANNEL 1 
REFERENCE (adjust until a full view is obtained or use AUTO SCALE) 
 REFERENCE POSITION, 
 REFERENCE VALUE, 
 SCALE/DIV 
Select CHANNEL 2 and similarly adjust its vertical axis scaling. 
Channel 1 and/or Channel 2 may require averaging/smoothing. 

 Select the channel 
AVERAGE  

AVERAGING (ON)   
   SMOOTHING (ON) 

Place markers at the resonant frequencies. 
Be sure to title the plots before printing. 

 
(ii) Referring to the  measured data, choose one filter having well defined resonant frequencies.  

Experimentally determine the susceptance of each iris at each of the measured resonant 
frequencies. Use the Network Analyzer and a matched load to determine susceptance values.   

Calculate susceptance values using the following equation: 
 

( )
b

SWR
SWReq = ±

− 1
 

Calculate the average susceptance at each of the resonant frequencies. 
 

(iii)Recalculate the resonant frequencies, of the selected filter, using the average susceptance 
value obtained in step 2. 
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Part B:  Frequency Meter 
 
I. Predicted Results 
 
1. Record the average susceptance value, at 10 GHz, for each iris from the data obtained in 

Experimental 6, Waveguide Irises. 
 
2. Using the average susceptance values, calculate the resonant frequencies of each frequency 

meter to be built from an iris and a short.  The length  of the waveguide to be used for 
constructing the filters must be measured.  The system is shown in Figure 2. 

 
 
 
 
 
 

 
 
 

 
 

Fig.2  Block Diagram of Waveguide Frequency Meter 
 
II. Measurements 

 
1. Construct each frequency meter and use the Network Analyzer to plot the forward reflection, 

S11, over the frequency range of 8-12  GHz.  Follow the same procedure outlined in part A. 
 
2. Referring to the plotted data, choose one frequency meter having well defined resonant 

frequencies (most likely the one with the circular iris).  Experimentally determine the 
susceptance of each iris at the resonant frequencies indicated on the plot. Use the Network 
Analyzer and a matched load to determine susceptance values.     

 
Calculate susceptance values using the following equation: 

 
( )

b
SWR

SWReq = ±
− 1

 

Calculate the average susceptance at each of the resonant frequencies. 
 
3. Recalculate the resonant frequencies, of the selected filter, using the average susceptance 

value obtained in step #2 
 

 
 
 

l

Port 1 
of  

N. A. 

Coax - 
Waveguide 

Adapter 
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Design 
Projects 
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Project I - Microstrip Power Divider for Arbitrary Power Division 
 
 
 
 
 

 
 
 
 
 
 
(i) Analytical Development 

For a power division ratio, 2

1

P
P

   =α
 obtain expressions for Z01 and Z02, such that ZTAA = Z0 

 

Answer           1   ZZ  Z

  1  1   ZZ  Z

L 002

L 001

α+=

α
+=

 
 
(ii) Theoretical Design 
 
Use Designer, to design in microstrip configuration the power divider shown above. 
Frequency, f = 10 GHz 
Substrate dielectric constant εr = 2.33 
Substrate thickness, h = 1/32” 
Z0 = 50 Ω 
Use a microstrip patch antenna for the load ZL 
 
(iii) Construction  (coordinated with the entire class)  
Layout using CAM350 and submit for chemical etching.    
 
(iv)Testing and Characterization 
 
Measure the S-matrix, SWR, Return Loss to validate your design  
 
(v) Report 
  
Submit a complete report to include all of the above. 

Zo 

 

 

 

 

 λ/4 

 λ/4 

P2 

P1 
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Project II - Microstrip Hybrid Quadrature for Arbitrary Power Division 

  
 
 

                                                                                                                 
(i) Analytical Development 
 
 Use the even-odd mode analysis to derive design equations for a quadrature hybrid coupler (find 

ZA and ZB )with an arbitrary power division of 
3

2

P
P   =α with input at port #1 (and matched) and 

port #4 isolated. 
 
(ii) Theoretical Design 
 
Use Designer, to design in microstrip configuration the quadrature hybrid coupler shown above. 
  
Frequency, f = 10 GHz 
Substrate dielectric constant εr = 2.33 
Substrate thickness, h = 1/32” 
Z0 = 50 Ω 
 
(iii) Construction  (coordinated with the entire class)  
Layout using CAM350 and submit for chemical etching.   
 
(iv)Testing and Characterization 
 
Measure the S-matrix, SWR, Return Loss to validate your design  
 
(v) Report 
  
Submit a complete report to include all of the above. 
 
 
 
 
 
 
 
 

1 2 

3 4 

Zo 

Zo 

Zo 

Zo 

ZA 

ZA 
 

ZB ZB λ/4 

λ/4 
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Project III - Bailey Unequal Split Power Divider 

  
 
 
 
 
 
 
 

 
 
(i) Analytical Development 
The Bailey unequal power divider uses a 900 hybrid coupler and a T-junction, as shown below. 
The power division ratio is controlled by adjusting the feed position ‘a’ along the transmission 
line of length ‘b’ that connects ports1 and 4 of the hybrid. A quarter wave transformer of 

impedance 2
Z0

is used to match the input of the divider. For  4  b λ=
  the output power division 

ratio given by 
  

b 2
a   tan 

P
P  2

2

3 ⎟
⎠
⎞

⎜
⎝
⎛=

π

 
 
(ii) Theoretical Design 
Use Designer, to design in microstrip configuration the Bailey coupler shown above for   

Power ratio  2
1   

P
P

2

3 =
 

  
Frequency, f = 1 GHz 
Substrate dielectric constant εr = 2.33 
Substrate thickness, h = 1/32” 
Z0 = 50 Ω 
 
(iii) Construction  (coordinated with the entire class)  
Layout using CAM350 and submit for chemical etching.   
 
(iv)Testing and Characterization 
Measure the S-matrix, SWR, Return Loss to validate your design  
 
(v) Report 
Submit a complete report to include all of the above. 

1 2 

3 4 

  
2

Z0  
Zo 

P1 
Zo 

b 

a 

P2 

P3 
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Project IV- Impedance Matching  
 
(i) Analytical Development 
 
Design the following impedance matching circuits to match 100 (Ω) to 50 (Ω) transmission line. 

• Single stub tuner using a open circuited 50Ω stub (f = 10 GHz) 
• Double stub tuner using open circuited 50Ω stubs placed 0.375λ apart and the first stub 

0.125λ from the load. (f = 10 GHz) 
• L-C circuit  (f = 200 MHz) 

 
  
(ii) Theoretical Design 
 
 Use Designer to design the circuits in microstrip configuration. 
 
Substrate dielectric constant εr = 2.33 
Substrate thickness, h = 1/32” 
Z0 = 50 Ω 
 
(iii) Construction  (coordinated with the entire class)  
 
Layout using CAM350 and submit for chemical etching.   
 
 
(iv)Testing and Characterization 
 
Measure the S-matrix, SWR, Return Loss to validate your design 
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Project V - Low Pass Filter and Band Pass Filter 
  

Objective  
 
1.. Use the filter tool in Designer to design the following circuits in microstrip configuration 

                                            
(a) Stepped Impedance Lowpass Filter 

• Cutoff Frequency: 2.5GHz 
• Filter Order: 5 
• Filter Response: Maximally Flat 
• System Impedance: 50Ω 
• Stepped Impedance Sections 20Ω ≤ Z0 ≤ 120Ω 
• Relative Permittivity: 2.33 
• Substrate Thickness: 31 mils 

 
(b) Coupled Line Bandpass Filter  (edge coupled) 

• Lower Cutoff Freq: 2.6GHz 
• Upper Cutoff Freq: 3GHz 
• Filter Order: 5 
• Filter Response: Maximally Flat 
• Maximum Return Loss: -15dB (in the Passband) 
• System Impedance: 50Ω 
• Relative Permittivity: 2.33 
• Substrate Thickness: 31 mils 

(c) (C ) Hairpin Bandpass Filter 
• Lower cutoff frequency: 5.8 GHz 
• Upper cutoff frequency: 6 GHz 
• Filter order: 7th 
• Filter Response: Chebyshev, ribble 0.1 dB 
• System Impedance 50 ohms 
• T-line imp., 40 ohms (Z for filter sections) 
• Relative Permittivity: 2.33,  “Rogers 5870” 
• Substrate thickness: 31 mils 
• Check box for optimize bandpass corners 

 
2. Import the filter into the circuit simulator and analyze  
3. Change the transmission line lengths to optimize the design 
 
(iii) Construction  (coordinated with the entire class)  
Layout using CAM350 and submit for chemical etching.   
 
(iv)Testing and Characterization 
 
Measure the S-matrix, SWR, Return Loss to validate your design 
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Project VI - Microwave Circuit 
  

 
Theoretical Design 
 
Either 
 
Design a microwave circuit to perform a specified task. The circuit should include at least one 
filter and one power divider from projects 1 through 4  
 
Frequency,  f = 2.5 GHz 
Substrate dielectric constant εr = 2.33 
Substrate thickness, h = 1/32” 
Z0 = 50 Ω 
 
Or 
 
Design a microstrip antenna array. The feed system should include at least one of the 
components that you have optimized in projects 1 through 4.   
 
Frequency, f = 10 GHz 
Substrate dielectric constant εr = 2.33 
Substrate thickness, h = 1/32” 
Z0 = 50 Ω 
 
 
(iii) Construction  (coordinated with the entire class)  
 
Layout using CAM350 and submit for chemical etching.   
 
.  
 
(iv)Testing and Characterization 
 
Measure the S-matrix, SWR, Return Loss to validate your design 
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CAM350 v9.0 Tutorial by: George Shieh 
  
This is a brief tutorial on how to use the CAM350 program to import multiple gerber data, 
arrange the layout onto one single layer, and export it into one single gerber file. For a more 
detailed description of CAM350, please refer to the help file.  
 
I. Getting Started 

1) If the panel is 18”x24”, the actual working space will be 16.5”x22” due to tooling holes, 
coupons, and borders. Make sure the units are in English by going to the Settings menu, 
and clicking Units… 

2) To create a border, go to the Add menu, and click Border.  
3) The bottom left side of the screen should read Border: Enter first point… 
4) Input the X coordinate on the bottom left side of the screen, press enter, then input the Y 

coordinate, and press enter again. Proceed to do this for the next set of points. Right-click 
any where on the screen when the border is complete. 

5) i.e. for the 16.5”x22” workspace 
  X: -8.25 Y: -11 
  X: -8.25 Y: 11 
  X: 8.25 Y: 11 
          X: 8.25 Y: -11 
  X: -8.25 Y: -11 

6) Next, from the Tables menu, click Composites…  
7) Click Add, then rename the composite, and click OK. 

 
II. Working with Gerber Data 
 

1) To import a gerber file, go to the File menu, then to the Import sub menu, and click 
AutoImport... 

2) Go to the directory with your gerber files, single click any one of them, and click Next. 
3) Make sure the correct gerber data are selected to be imported, and click Finish. 
4) Next, from the Tables menu, click Composites… Make sure the composite that was 

created earlier is highlighted. Click an available layer number, i.e. 1. The Layer list will 
appear, and then choose your gerber file. Click Redraw to verify that the correct layer has 
been selected. If not, then reassign the layer number. Finally click OK.   

5) To move the layout, double click the gerber file name on the left hand window. In the Edit 
menu, click Move. Push W on the keyboard. Left-click once, drag the mouse to select the 
entire layout, and left-click again. Push W on the keyboard again. Left-click once to pick 
up the layout, and left-click again to drop it. Right-click to exit the Move mode. 

6) All other manipulations in the Edit menu are done in the same way. 
7) Measurements of length can be done in the Info menu, Measure, and Point-to-Point.  

 
III. Exporting to Single Gerber File 

1) To export the completed layout to a single gerber file, go to the File menu, Export, and 
click Composites… 

2) Make sure that the Data Format is RS274-X. Pick the Export path, file name, and make 
sure that EXP is checked. Finally, click OK. 
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B. The 8720B Network Analyzer 
 
 
To learn the following on the Network Analyzer (NA): 
 
(a) To create a new CALKIT for waveguides 
(b) To calibrate in the x-band for full 2-port 
(c) To save both of the above on disk 
 
(i) Create a User CALKIT for Waveguide Measurements 
 
CAL 
 MORE 
  SET zo (Enter appropriate value) 
  RETURN 
 CAL KIT [3.5 mm] 
  MODIFY [3.5 mm] 
   DEFINE STANDARD (Enter number) 
    SHORT 
     SPECIFY OFFSET 
      OFFSET DELAY (Enter value) 
      OFFSET LOSS  " 
      OFFSET zo   " 
      MINIMUM FREQ.  " 
      MAXIMUM FREQ. " 
      WAVEGUIDE  " 
      STD. OFFSET DONE 
     LABEL STANDARD 
      ERASE TITLE 
      SELECT LETTER (Enter label) 
      DONE 
     STD. DONE (DEFINED) 
   DEFINE STANDARD (Repeat for as many stds.) 
   SPECIFY CLASS S11 A 
    SPECIFY: (Press proper class) 
          (Enter calibration standard # for all loads) 

   CLASS DONE (SPEC'D) 
   LABEL CLASS XSHORT 1 
    LABEL: (Press proper class) 
     ERASE TITLE 
     SELECT LETTER (Enter label) 
     DONE 
    LABEL DONE 
   LABEL CLASS (Repeat for rest) 
   LABEL KIT 
    ERASE TITLE 
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    SELECT LETTER (Enter label) 
    DONE 
   KIT DONE (MODIFIED) 
 
  SAVE USER KIT 
  RETURN 
 
 
 

Standard Offset Frequency (GHz)   
 
 

No. 

 
 

Type 

Linear 
Delay 
(psec) 

 
zo 

(Ohms)

 
 

Loss 

 
 

Min 

 
 

Max 

Coax or 
Wave-
guide 

 
Standard 

Label 
1 λ

8  short 
16.187 1 0 6.557 13.114 W/G xshort1 

2 3λ
8  short 

48.560 1 0 6.557 13.114 W/G xshort2 

3 Load (fixed) 0 1 0 6.557 13.114 W/G xload 
4 THR11 0 1 0 6.557 13.114 W/G thru 

 
Table 1  Standard Definitions 

 
 
 
 

 
Standard Class 

 
Standard Number(s) 

 
Class Label 

s11 A 1 xshort1 
s11 B 2 xshort2 
s11 C 3, 5 xload 
s22 A 1 xshort1 
s22 B 2 xshort2 
s22 C 3, 5 xload 

Forward Transmission 4 thru 
Reverse Transmission 4 thru 
Forward Match 4 thru 
Reverse Match 4 thru 
Frequency Response 1, 2, 4 response 

 
Table 2  Standard Class Assignment 

 
 
(ii). Calibration Procedure for 8720B Network Analyzer 
 
START (Enter appropriate frequency range) 
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STOP (Enter appropriate frequency range) 
RECALL 
 LOAD FROM DISK 
  LOAD __________ (Load proper CALKIT) 
  RETURN 
CAL 
 CAL KIT __________ 
  CAL KIT : (Press USER KIT) 
  RETURN 
 CALIBRATE MENU 
  CALIBRATE: (Press FULL 2-PORT) 
   REFLECT'N 
    (Connect std's and press key) 
    (Standard names should appear as in CAL KIT) 
    LOAD 
     LOAD  
     DONE: LOAD 
    REFLECT'N DONE 
   TRANSMISSION 
    (Connect ports and press keys) 
    (Standard names should appear as in CALKIT) 
    TRANS. DONE 
   ISOLATION 
    OMIT ISOLATION 
    ISOLATION DONE 
   DONE 2-PORT CAL 
  

The SAVE menu will automatically be displayed. 
The calibration data must be stored in a register. 

TITLE REGISTER 
 TITLE __________ 
  ERASE TITLE 
  SELECT LETTER  (Enter appropriate title) 
  DONE 
 RETURN 
SAVE 

Next Store the data on disk. 
 
STORE TO DISK 
 TITLE FILES 
  COPY FROM REG. TITLES 
  RETURN 
 STORE _________ 
 
 
 
  


